Automated Dispatch System

ADS 5.1.9.3 GUI Specification
New ISO Market
September 17, 2012
## Version History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
</table>
| August 28, 2008   | 4.6     | Initial Draft. Included updates to version 4.6  
|                   |         | - Responding to Multiple Dispatches (2)  
|                   |         | - New Instruction Priority (3)  
|                   |         | - Additional Alarms (4)  
|                   |         | - Removal of DA AS Awards (5)  |
| September 18, 2008| 4.7     | Included updates to Client version 4.7  
|                   |         | - Enhanced Status Indicators and Message Display (6)  |
| November 10, 2008 | 4.9     | Included updates to Client version 4.9  
|                   |         | - Removal of TBD from the DOT Detail (7)  
|                   |         | - Enhanced Response to Partial Instructions (8)  
|                   |         | - Provided Intertie ID Column on GUI (9)  
|                   |         | - Provided Schedule MW Column on GUI (9)  
|                   |         | - Operator Initiated Messages (10)  |
| January 6, 2009   | 4.10    | Included updates to Client version 4.10  
|                   |         | - New DOT Delta and Prev. DOT Columns (11)  
|                   |         | - New RT Interval Column (12)  
|                   |         | - Suppression of Deferred dispatches on the GUI (13)  |
| May 29, 2009      | 4.13    | Included update to Client version 4.13  
|                   |         | Pre-Summer Release  
|                   |         | - Audible Alarms Enhancement (14)  
|                   |         | - Enhanced Batch Status/Interval Displays (15)  
|                   |         | - Additional Columns to GUI (16)  
|                   |         | - Renamed Column Headings from OOS to Exceptional Dispatch (17)  |
| September 22, 2010| 5.1.8   | Included update to Client version 5.1.8  
|                   |         | - Data Added to Support MSG (18)  
|                   |         | - RMR and AGC Flag Added (18)  
|                   |         | - Multiple download versions for Query Tool (19)  |
September 17, 2012

5.1.9.2

Included update to Client version 5.1.9.2

Contingency Dispatch Enhancement

- Contingency Type Added to GUI and Query Tool (20)
- Path Exclusion Added to GUI and Query Tool (20)

Help Desk Submissions (21)

---

**Table of Contents**

1. Introduction ........................................................................................................................................... 5
   1.1 Objective ........................................................................................................................................ 5
   1.2 Overview of Latest Release ........................................................................................................... 5

2. Responding to Multiple Dispatches (version 4.6) .............................................................................. 5
   2.1 Business Requirement .................................................................................................................... 5
   2.2 Usability / Design ............................................................................................................................ 5

3. New Instruction Priority (version 4.6) .................................................................................................. 6
   3.1 Business Requirement .................................................................................................................... 6
   3.2 Usability / Design ............................................................................................................................ 6

4. Additional Alarms (version 4.6) .......................................................................................................... 6
   4.1 Business Requirement .................................................................................................................... 6
   4.2 Usability / Design ............................................................................................................................ 7

5. Removal of Day Ahead AS Awards (version 4.6) ............................................................................... 7
   5.1 Business Requirement .................................................................................................................... 7
   5.2 Usability / Design ............................................................................................................................ 7

6. Explanation of Status Indicators and Interval Displays (version 4.7) .............................................. 7
   6.1 Business Requirement .................................................................................................................... 7
   6.2 Status Indicator Screenshot from Development Environment ..................................................... 8
   6.3 Definition of Indicators and Interval Displays .............................................................................. 8
   5 Minute ................................................................................................................................................ 8
   Hourly .................................................................................................................................................. 8
   15 Minute .............................................................................................................................................. 9

7. Removal of TBD from the DOT Detail (version 4.9) ...................................................................... 9
   7.1 Business Requirement .................................................................................................................... 9
1. Introduction

1.1 Objective

The objective of this document is to provide detail into the enhancements made to the Automated Dispatch System (ADS). The scope of this document is limited to the incremental updates made to the ADS Client version 4.6 and greater, which is the Graphical User Interface (GUI), as well as any CAISO server changes that impact the ADS Client. This document will describe the business requirement for each change as well as provide details on using the new features. ADS Client updates that only involve bug fixes and do not have an impact to functionality or usability of the ADS Client will not be described in this document.

Additional Information regarding dispatching rules and procedures can be found in the Business Practice Manuals for Market Operations and Market Instruments, which can be downloaded at: http://www.caiso.com/235f/235f939f8dc0.html

1.2 Overview of Latest Release

The latest updates to the ADS Client will be delivered in version 5.1.9.2. The latest enhancements to the ADS Client include new columns to support Contingency Dispatch enhancements.

2. Responding to Multiple Dispatches (version 4.6)

2.1 Business Requirement

Participants have approximately five minutes to respond to Hourly Predispatch Instructions. In order to help users respond in a timely manner, the ADS Client now supports the ability to select multiple dispatches and enter a single response for all dispatches selected. This feature is in addition to the existing feature which allowed users to accept or decline all dispatches for the current interval.

2.2 Usability / Design

The selection of multiple dispatches is similar to other Windows bases applications. The user holds the Ctrl or Shift key on the keyboard and then selects the instructions that they want to respond to with the same response. After the desired instructions are selected, the user then makes a selection the new Accept or Decline window in the upper left hand corner of the screen. Please note that a response for a partial quantity is not compatible with this feature and must continue to be responded to individually.
3. **New Instruction Priority (version 4.6)**

3.1 **Business Requirement**

All Hourly Predispatch instructions display on the GUI as requiring a response. These instructions can contain components from the Day Ahead Market as well as the Supplemental Market. If an instruction does not get responded to, the ADS application will default to a decline of the portion of the instruction from the Supplemental Market. Due to the concerns over data volume and a limited amount of time to analyze and respond to instructions, it is important to distinguish which instructions contain a supplemental component that will be declined if it is not accepted.

3.2 **Usability / Design**

A new priority sort level has been added to allow instructions with a supplemental component to be displayed at the top of the screen. The assigned priority of each instruction is also an available field on the GUI, which can be viewed, hidden, or filtered on. The priorities are listed below.

New priorities:
- 0. Instructions requiring a response with Supplemental Energy values. These instructions will be flashing in Green (until responded, then solid Green.) *NEW*
- 1. Instructions requiring a response without Supplemental Energy values. These instructions will be flashing in Green (until responded, then solid Green.)
- 2. Instructions not requiring a response but with Delta DOT <> 0 and all OOS Fixed DOT instructions. These instructions will be solid Green.
- 3. All other instructions. These instructions will be solid Aqua.
- 99. Resources with no current instructions (inactive). These instructions will be solid Gray.

For reference the previous priorities were:
- 0. Instructions requiring a response
- 1. Instructions not requiring a response but with Delta DOT <> 0 and all OOS Fixed DOT instructions
- 2. All other instructions
- 99. Resources with no current instructions (inactive)

*Note: The new instruction priority was an enhancement to the CAISO server code and does not require the user the download an updated ADS Client. This enhancement was installed along with other patches to the CAISO server code on August 17, 2008.*

4. **Additional Alarms (version 4.6)**

4.1 **Business Requirement**

The ADS Client has existing alarms for 5 minute and Hourly instructions, similar to the production version of ADS. The alarms offer an audible alert when instructions are received and can be configured to have a unique sound for each type of instruction. In the summer of 2008, the production version of ADS was enhanced to include an audible alarm for dispatch instructions from a contingency run. Due to contingency runs continuing to be intermittent by design, the
need for an audible alarm for contingency runs will still exist in the post MRTU environment. In addition, Ancillary Service (AS) Awards were added to the MRTU version of ADS but did not have the option of an audible alarm, so a new alarm for AS Awards has been added.

4.2 Usability / Design

The alarms for both Contingency Instructions and AS Awards are optional and can be turned on and off by a selection box found under the Options menu.

To further assist users in monitoring instruction activity, a message box has been added to the top of the display. This provides a summary of batches received and includes a timestamp and batch description.

5. Removal of Day Ahead AS Awards (version 4.6)

5.1 Business Requirement

ADS in intended to provide real time dispatch instructions to offer a more efficient way of managing grid operations. ADS data requirements must remain focused on real time operations. ADS will continue to display the total AS awarded, but will no longer display the breakdown from the DA market. The DA AS Awards will be available in CAISO Market Results Interface (CMRI).

5.2 Usability / Design

The DA MW Qty will no longer be available on the GUI.

6. Explanation of Status Indicators and Interval Displays (version 4.7)

6.1 Business Requirement

Since the 4.6 specification posting in late August, 2008, there has been several questions regarding how to interpret the different intervals and batch statuses. In the past, ADS would display a status of “Idle” when it was waiting for the next set of instructions or between response windows. Since the “Idle” state would be displayed even when current data was being displayed, it created confusion and did not create much value. Therefore, the “Next Binding Interval” has been replaced with “Dispatch Interval”, which is based off of data actually received rather than the ISO clock. The Status indicator has also been enhanced to describe the type of instructions received. Lastly, a "Messages" box has been added to allow users to view the input activity into the ADS Client.
6.2 Status Indicator Screenshot from Development Environment

6.3 Definition of Indicators and Interval Displays

5 Minute

<table>
<thead>
<tr>
<th>Indicator/Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Interval</td>
<td>Displays the current 5 minute interval based on the current ISO clock. This will change as time moves forward.</td>
</tr>
<tr>
<td>Dispatch Interval</td>
<td>Displays the 5 minute interval corresponding to the latest RT DOT dispatch data received from RTM. Will display Idle if dispatch data is not available or is outdated.</td>
</tr>
<tr>
<td>Status: AS</td>
<td>This will illuminate [OOS] (yellow) when OOS instructions are in effect for the Current 5 minute. It will appear [OOS] (disabled) when OOS instructions are not applicable.</td>
</tr>
<tr>
<td>Status: DOT</td>
<td>This will illuminate [DOT] (red) when RT DOT values are available for the Dispatch Interval and the current time has not reached the start of the Dispatch Interval, otherwise it will appear [DOT] (disabled).</td>
</tr>
</tbody>
</table>

Hourly

<table>
<thead>
<tr>
<th>Indicator/Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Interval</td>
<td>Displays the current hourly (60 minute) interval based on the</td>
</tr>
</tbody>
</table>
current ISO clock. This will change as time moves forward.

<table>
<thead>
<tr>
<th>Interval/Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Interval</td>
<td>Displays the current 15 minute interval based on the current ISO clock. This will change as time moves forward.</td>
</tr>
<tr>
<td>Dispatch Interval</td>
<td>Displays the 15 minute interval corresponding to the latest RT AS and/or Unit Commitment dispatch data received from RTM. Will display Idle if dispatch data is not available or is outdated.</td>
</tr>
<tr>
<td>Status: OOS</td>
<td>This will illuminate AS (red) when RT AS Awards are available for the Dispatch Interval and the current time has not reached the start of the Dispatch Interval, otherwise it will appear (disabled).</td>
</tr>
<tr>
<td>Status: DOT</td>
<td>This will illuminate DOT (red) when RT DOT values are available for the Dispatch Interval and the current time has not reached the start of the Dispatch Interval, otherwise it will appear (disabled).</td>
</tr>
<tr>
<td>Status: Timer</td>
<td>Will display the time remaining in the current response period if applicable, otherwise will display hourly DOT status.</td>
</tr>
</tbody>
</table>

15 Minute

7. Removal of TBD from the DOT Detail (version 4.9)

7.1 Business Requirement

ADS receives a breakdown of the RT DOT from the upstream market application. The breakdown quantities include the following:

SCHD – RT Self Scheduled Energy
SUPP – Supplemental Energy
RMPS – Standard Ramping Energy
SPIN – Spin (Included in SUPP)
NSPN – Non Spin (Included in SUPP)
MSSLF – Load Following Energy

The TBD quantity was calculated by taking the sum of the detail records and subtracting the total from the DOT. Since SPIN, NSPN, and MSSLF are already included in the SUPP value, the TBD calculation has been incorrect. In addition, the TBD quantity is not creating any value, so ADS will now display the detail records exactly as they are provided by the upstream market application and no longer calculate a TBD quantity.

8.  Responding to Partial Instructions (version 4.9)

8.1 Business Requirement

The functionality for responding to Partial Instructions has been enhanced by adding a new Partial button next to the existing Accept andDecline buttons. This update was made to correct defect, #15872, which reported the response window closing each time ADS refreshed.

8.2 Usability / Design

The response window is now a floating window that will not be impacted when the ADS grid refreshes. The floating window can be accessed highlighting the instruction and clicking the Partial button.

Only the supplemental energy portion of a Hourly predispatch instruction can be declined. However, ADS was still allowing users to attempt to respond to instructions that did not contain supplemental energy. ADS would then return a message that the response mw must be between, say 50mw and 50 mw. In order to avoid this unintended behavior, a user can no longer attempt to decline or partially respond to instructions without supplemental energy.

9.  Intertie and Schedule MW Columns (version 4.9)

9.1 Business Requirement

9.1.1 Intertie

For MRTU, the resource id for Interchanges is SC specific and includes the four digit SC id in front of the interchange. Therefore, a sort by resource id will only provide a summary by SC id, not interchange. In order to provide a summary by Interchange, a new intertie id column is being added by removing the first four characters from the resource id for all ITIE and ETIE resources. The new intertie id column will not be part of the default view but can be added using the Field Chooser option by right clicking on one of the existing column headings.

9.1.2 Schedule MW

The SCHD value already displayed in the DOT breakdown will now also be an available column on the GUI. The new Schedule MW column will not be part of the default view but can be added using the Field Chooser option by right clicking on one of the existing column headings.
10 Operator Initiated Messages (version 4.9)

10.1 Business Requirement

In the event that a CAISO operator would like to communicate a message to all ADS users, the CAISO operator will have the option of choosing from predefined messages, as well as creating a custom message. The message will display on the main pane for all users. ADS will also log all messages that are sent.

11 New DOT Delta and Previous DOT Columns (version 4.10)

11.1 Business Requirement

The DOT Delta column in versions prior to 4.10 compared the current DOT with a previous DOT that had the greatest start time. This resulted in 5 minute RT instructions being compared with Hourly instructions rather than the previous 5 minute instruction, since the Hourly instruction has a start time up to an hour into the future. This calculation is not correct, so it was replaced by DOT Delta and Previous DOT columns for both batch types.

11.2 Usability / Design

The DOT Delta and Prev DOT columns are being replaced by four new columns, RT DOT Delta, RT Prev DOT, Hourly Delta DOT, and Hourly Prev DOT. The calculation for new RT columns include the standard 5 minute instructions as well as exception dispatch (OOS), and contingency dispatches. The calculation for the new Hourly columns only include instructions from the Hourly Predispatch run.

12 New RT Interval Column (version 4.10)

12.1 Business Requirement

There is a need for users to filter for dispatches that occur at specific interval, such as at the top of the hour. Since filtering on the Start Time does not always work do to the timestamps having a finer granularity than is actually visible on the GUI, an Interval number was added. This will allow users to filter for instructions that occur at a specific interval, without having to update the filter ever hour.

13 Suppression of Deferred Batches on the GUI (version 4.10)

13.1 Business Requirement

In the event that a dispatch is created by our Market Systems, but fails to be sent out by ADS within the appropriate timeframe, there may still be the need for the data to be received for Settlement purposes. An example would be if a dispatch was created but communicated by some other mechanism, other than ADS, such as the telephone.
13.2  Usability / Design

When the expired instructions become available the batch will be labeled with the existing batch status = 6, meaning deferred. Deferred batches will not be displayed on the GUI; however will be available via the API and Query Tool. Deferred batches are for Settlements purposes only and should not be used for operations since the interval of the dispatch would already be expired.

14  Audible Alarms Enhancement (version 4.13)

14.1 Business Requirement

When batches of different types are received at the same time, ADS triggers all applicable alarms. The Windows API method used by ADS, only guarantees a single audible alarm being played at a time. The audible alarms enhancement will allow for multiple alarms to be heard when different batch types are received at the same time.

14.2 Usability / Design

14.2.1  Additional features have been added under the Alarms tab, found under the File / Options menu. Please see new Alarm tab below:

New Alarm Tab

14.2.2  The user has the option to set priorities by batch type. This will determine which alarm will be played first when there are multiple batches received at the same time.

14.2.3  The default Alarm has been changed to a verbal description of the batch. Changing alarm sounds can now be set on the Alarms tab, rather than navigating to the system Control Panel.
14.2.4 In addition to the existing Audible Sounds, an option has been added to display a Popup Window for the desired batch type.

14.2.5 Alarms are now available for Exceptional Dispatch Instructions.

15 Enhanced Batch Status/Interval Display (version 4.13)

15.1 Business Requirement
Once the alarm is triggered and acknowledged, the user must have the ability to see when the batch was sent.

15.2 Usability / Design
All batch types have been added to the Batch Status display which now includes the batch receipt time. To make it easier to quickly view the data in a particular batch, the ability to highlight and filter by batch type was added to the Batch Status display. Please see new Batch Status display below:

New Batch Status / Interval Display / Alarm Management Panel

15.2.1 When a new batch is received, the column for the received batch will flash red until acknowledged by clicking on the column.

15.2.2 Selecting the column will acknowledge the alarm which will stop the column from flashing red. Selecting the “Clear All Alarms” button will acknowledge the alarms.

15.2.3 When a column is selected, all resources with records for the received batch will be highlighted. A second click on the column will remove the highlight.

15.2.4 When the filter box is selected, only resources with records for the filtered batch will be displayed.

15.2.5 When the Continuous Alarm on Receipt of New Instructions is selected, the alarm will run continuously until acknowledged, as it did before the alarms enhancement. A user must select on the Batch Column to acknowledge the batch which will mute the alarm.

16 Additional Columns Added to GUI (version 4.13)

16.1 Business Requirement
In order to easily determine which resources have supplemental energy and must be responded
to for Hourly Instructions, the Hourly Supplemental Energy column was requested to be added as an available column on the GUI.

16.2 Usability / Design
All DOT breakdown records which could be seen by placing the mouse over the red triangle on the DOT, are not available columns on the GUI. The new records are labeled RT and Hourly which correspond to the batch type. To add and remove columns on the GUI, right click on any column header and select Field Chooser. Columns can then be dragged on and off the display.

17 Renamed Column Headings from OOS to Exceptional Dispatch (version 4.13)

17.1 Business Requirement
OOS is no longer a valid term with the new market design and has been replaced by Exceptional Dispatch. Exceptional Dispatch columns are abbreviated as “ED”.

Note: In order to minimize impact to users, the OOS fields on the API and Query Tool file were not renamed at this time.

18 New Data for version 5.1.8

18.1 New Columns
The table below contains a summary of the new columns added to both the ADS GUI and Query Tool.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
<th>RT and Hourly Tab</th>
<th>Query Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGC</td>
<td>The AGC status will communicate when a resource was on AGC at the start of the RT market run. Instructions will be populated with a &quot;Y&quot; or &quot;N&quot;.</td>
<td>Default</td>
<td>Available</td>
</tr>
<tr>
<td>RMR</td>
<td>The RMR flag will communicate when a resource is being incremented above the day-ahead schedule in real time, due to a RMR contract. Instructions will be populated with a &quot;Y&quot; or &quot;N&quot;.</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Config ID</td>
<td>Displays the configuration associated with the dispatch.</td>
<td>Default</td>
<td>Default</td>
</tr>
<tr>
<td>Commitment To Config</td>
<td>Displays the configuration that a resource should be transitional to when a transition instruction is sent.</td>
<td>Default</td>
<td>Default Labeled as &quot;Trans To Config ID&quot;</td>
</tr>
<tr>
<td>Commitment From Config</td>
<td>Displays the configuration that a resource should be transitional from when a transition instruction is sent.</td>
<td>Available</td>
<td>Default Labeled as &quot;Trans From Config ID&quot;</td>
</tr>
</tbody>
</table>

Note: Transition Instructions are a new type of commitment instruction for MSG resources that communicate when a resource must transition between configuration ids. The Unit Commitment column will be populated with “Transition” when a Transition Instruction is received for a resource.

19 Query Tool XML Download Options (version 5.1.8)

The Query Tool now supports two download versions in order to match the xml schemas supported for the API. The new data fields provided with this release will only be available with the ADS API Version 2. The default is ADS API Version 2, so users that want to download production data prior to ADS version 5.1.8 being moved to production in October 2010 must select ADS API Version 1. Market Simulation environments are already supporting both versions.

The Query Tool Options tab is available by selecting Options under the File menu.
20 Contingency Dispatch Enhancements (version 5.1.9.3)

20.1 New Columns

The table below contains a summary of the new columns added to both the ADS GUI and Query Tool. Both columns are available under the field chooser and can be added to the user’s default view. The field chooser is accessed by right clicking on the column header.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
<th>RT and Hourly Tab</th>
<th>Query Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contingency Type</td>
<td>The Contingency Type will communicate when operating reserves are prioritized over energy-only bids, which will be labeled as RTDD, Real-Time Disturbance Dispatch. The existing non RTDD contingency dispatches are labeled RTCD, Real-Time Contingency Dispatch.</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Path Exclusion</td>
<td>The Path Exclusion will communicate when a group of interties were excluded from a Contingency Dispatch market run. The field will display NTE when Northern ties (those delivered over scheduling points North of path 26) were excluded. The field will display STE, when Southern ties (those delivered over scheduling points South of path 26) were excluded. The field will display NSTE, when both Northern and Southern ties were excluded.</td>
<td>Available</td>
<td>Available</td>
</tr>
</tbody>
</table>

20.2 Query Tool API Transition

The Query Tool supports two API Versions. The API Version can be selected on the Query Tool tab found on the File/Options menu.

ADS API Version 1 will correspond with the v4 API found at:  
https://adssta.caiso.com:447/ADS/APIWebService/v4  
https://adssta.caiso.com:447/ADS/APIResponseWebService/v4

The default is ADS API Version 2 and will correspond with the v5 API found at:
Version 3.1 (in production as of 4/1/2009), has been deprecated and is no longer supported.

21 Submit Bug Report (version 5.1.9.3)

The Submit Bug Report, found under the Help menu, can be used to submit issues or questions to the CAISO Helpdesk. Submissions will follow the same process as when a user calls and logs a ticket with the Help Desk. For data related issues, please include all relevant metadata such as date, time, resource id, etc. All submissions should also include the following contact information:

1. Name:
2. Company:
3. Email address:
4. Contact Phone:

Please note that bug report submissions on prior versions of ADS will not be supported. Users on prior versions of ADS must call the Help Desk to have an issue logged.